Get started with Outlook for Windows email

This guide is for staff and research postgraduates
Welcome to Outlook for Windows email!

Outlook is one component of the Microsoft Office 365 suite, an integrated suite of tools. Over time an increasing number of University systems will be replaced by tools within the suite, so that everything works together.

This guide covers the following basic tasks:

- Open Outlook desktop
- Set your email signature
- Read, reply to, forward, delete and search for emails
- Create a new message
- Organise your email with folders, categories and flags
- Set your out-of-office message
- Access shared mailboxes
- Mark messages as junk mail or not junk
- Use rules (filters and forwarding) to control incoming mail
- Further support resources

Hint: this denotes something new or something that is done differently
Digital Workspace | Get started with Outlook for Windows email

Note that you can download and install Outlook for home use free. To do this, sign-in to your Office 365 account at [https://portal.office.com](https://portal.office.com), click on ‘Install Office 2016’ and follow the on-screen instructions.

Open Outlook desktop

To open Outlook desktop:

1. Click on the Windows ‘Start’ icon and start to type ‘Outlook’.
2. When ‘Outlook 2016’ appears in the results list, click on it in the list or press ‘Enter’ on the keyboard.
3. If you are prompted to sign in to Office 2016, do so using the long version of your username (e.g. abcde@bristol.ac.uk) followed by your normal password.

If you right-click on the app name before opening it, you can pin a shortcut to the ‘Start Menu’ and/or the ‘Taskbar’ to make it easier to access on future occasions.

Alternative ways to access Outlook email

You can also access Outlook email:

- Online via any modern web browser
- On mobile devices

Getting started guides for these are available from [www.bristol.ac.uk/email](http://www.bristol.ac.uk/email) (in the ‘Microsoft support’ section, select ‘Outlook email and calendar’ to see all support resources).

Power users - people with multiple shared mailboxes or many calendars - may find that the desktop version suits them better. Most things you need to do can be done from Outlook Online, and it is simple and easy to use.

Set your email signature

Note that your email signature may not be migrated from your Google account, so you may need to set this up first thing on day 1.

- Make sure that you know how the University expects you to format your signature; see guidance at [http://www.bristol.ac.uk/style-guides/visual-identity/email/](http://www.bristol.ac.uk/style-guides/visual-identity/email/)
To set your email signature:

1. Click on ‘New Email’ and, when the email window opens, select the ‘Message’ tab.
2. Click on the ‘Signature’ option (see right) and select ‘Signatures’.
3. Click on ‘New’ in the pop-up window, give the signature a name and save it.
4. In the ‘Edit signature’ box add the signature text.

5. In the ‘E-mail account’ field, make sure that your personal University account is selected then, in the ‘New messages’ and ‘Replies/forwards’ fields, choose the new signature name from the drop-downs and select ‘OK’.

You can create multiple signatures and assign different signatures to different mailboxes, e.g. your normal University account and shared accounts. In step 5, above, just choose the relevant account from the ‘E-mail account’ list and select whichever signature you’ve created for that mailbox.

Read, reply to, forward, delete and search for emails

Read your email

This is straightforward and shouldn’t cause any issues; just do one of the following:

- If an item is in your inbox, simply click on it in the list of mails to open and read it.
- If not in the inbox, select the folder that the email is in and do the same as above.
- If you can’t remember where an email is, search for it (see section on searching below).

Reply to and forward emails

Both are done the same way, though you have two options, based on whether the email is open or not.

To reply to or forward an email:

1. Select ‘Reply’, ‘Reply All’ or ‘Forward’ from the options in the top-left of the open email.
Delete an email

The easiest way to delete an email is to hover your mouse over the message in the email list and click on the ‘X’ that appears. When you delete an email, it goes into the ‘Deleted Items’ folder. After 30 days, it will disappear completely.

If you want to remove the email from your Inbox but keep it elsewhere in Outlook, so you can still search for it later if you need it, use the Archive function. Click on the email, to select it, and choose ‘Archive’ to remove the email from your inbox to your ‘Archive’ folder. The first time you do this, you will be shown a menu asking you to either create an archive folder or choose an existing folder.

There is a very large amount of space available for email and calendar in Outlook, so there is no need to delete messages just to save space.

Search for email

To search for an email:

1. Click in the ‘Search Current Mailbox’ field above the list of emails in the current folder.
2. Enter the search term; e.g. if you want to find messages from edward.elgar@bristol.ac.uk, type edward.elgar@bristol.ac.uk in the search box.
3. The default search is current mailbox, so if you want to search something else, click on the downward arrow on the box next to the search box and choose the relevant category, e.g. ‘All mailboxes’ to search everything.
4. Click on the magnifying glass icon (or press ‘Enter’).
5. Clear the search by clicking on the ‘X’ in the ‘Search Current Mailbox’ field (see right).

It is easy to search for messages from a specific person and also to specify what results are returned, for example:

- To find all emails containing the word Edward, type Edward
- To find just messages from Edward, type from:Edward
- To find all emails from Edward sent this week, type from:Edward received:this week
- To find emails from Edward that include attachments, type from:Edward hasattachments@yes
Create a new message

To create a new message:

1. In the ‘Home’ tab, click on ‘New Email’.
2. In the compose window, start to type the recipient’s name into the ‘To’ field and hit ‘Enter’ when it is highlighted in the list. See below for information on external contacts or if the recipient’s name does not appear in the list.
3. Enter a short and meaningful message subject, write the email – keep it short and to the point, with most important information at the start – and click on ‘Send’.

If you have previously sent an email to an external contact, Outlook remembers them and will show the email address for you to select as you start to type their email address.

Send a message with an attachment or with a Modern Attachment

To send a message with an attachment or Modern Attachment:

1. Open a new email, type the body and subject of your email as normal.
2. Click the Attach File button and choose your file (see ‘hint’ below) - either:
   a. Upload and attach as a OneDrive file (Modern Attachment)
   b. Attach as a copy (classic attachment)

Hint: on a University computer, after clicking ‘Attach’, you will find MyFiles and other existing file storage locations by selecting ‘Browse This PC…’; to find your OneDrive files select ‘Browse Web Locations’.

You now have a choice of how to attach files in Outlook. You can send a file attached to your email. You can also choose to send the file as a link within your OneDrive – a Modern Attachment.

What are Modern Attachments?

The problem with classic attachments is that as soon as you send one, you have created multiple versions of the file, and you no longer know which should be the definitive and correct version. When comments or changes are needed, everyone on the circulation list sends you a different version back, and it generally becomes difficult to reconcile all the changes.

Modern Attachments solve this. You choose the file from your OneDrive, and Outlook sends a link to the file out by email. This means there is only ever one copy.

If the file is a Word, Excel or PowerPoint document, any comments appear immediately, and everyone can see them. If changes are needed they can be made by any recipient, and are seen immediately by all. There is full version control, with roll back to a previous version if required.

Modern Attachments work even if the recipient is not a member of the University, or if they are accessing the file on a computer which does not have Microsoft Office installed.
External contacts

Type in the full address of people external to the University. If you save the address to your ‘Contacts’ then it should recognise as you start typing next time.

To save a new contact:

1. Click on the ‘People’ icon below the ‘Navigation pane’.
2. Click on ‘New’, choose ‘Contact’ and add the relevant details.

Drafts

Outlook saves unsent messages as drafts unless you specifically choose not to save a draft. Find saved drafts in the ‘Drafts’ folder.

Organise your email with folders, categories and flags

You can organise your mail using a combination of folders, categories and flags depending on what you want to do.

In Outlook, the primary organisational method is folders. You can only store an email in one folder at a time. This is different to Google, where an email can appear under multiple labels. However, if you want one email to appear in more than one place then use Outlook categories as well – see information on categories below.

Folders

To create a new top-level folder:

1. In the ‘Navigation pane’, right-click on your ‘Inbox’, and select ‘New Folder’.
2. Enter a relevant name and press ‘Enter’.

To create a sub-folder:

1. Navigate to the folder under which you want the new folder to appear and right-click on it.
2. Do the same as above.
To move email to a folder:

1. If just one email, click and hold the mouse on an email and drag to the required folder.
2. If multiple, contiguous emails, click on the first email, then hold down the ‘Shift’ key and click on the last, then click and hold the mouse on one of the selected emails and drag to the folder.
3. If multiple, non-contiguous emails, click on the first, then hold down the ‘Ctrl’ key and click each email in turn, then click and hold the mouse on one of the selected emails and drag to the required folder.

Categories

Color categories work like labels in Google and let you to easily identify and group associated items. You can assign a category to a group of interrelated items, such as contacts, appointments, and emails, so that you can quickly track and organise them.

You can also assign more than one category to items. The biggest advantage here is that an email can belong to, for example, your Most urgent category as well as to your Project XXX category, and you will find it when checking either category.

To create a category:

1. In the ‘Home’ tab, click on ‘Categorize’, and select ‘All Categories’, followed by ‘New’.
2. In the ‘Add New Category’ pop-up, type a name, select a colour and click on ‘OK’.
3. In the ‘Color Categories’ pop-up, click ‘OK’.

To add a category to an email:

1. Click on an email to select it.
2. Right-click on the email, click on ‘Categorize’, and select the relevant category.
3. To add further categories, with the email selected just repeat step 2, above.
To search by categories:

1. Click in the ‘Search Current Mailbox’ field and, if necessary, select a different search option in the ‘Current mailbox’ drop-down next to it.
2. In the ‘Search’ tab, select ‘Categorized’ and choose the category you want to view.
3. You can refine the search by adding more text after ‘category:="xxxx"’.
4. Clear the search by clicking on the ‘X’ in the ‘Search Current Mailbox’ field.

Flags

Applying a flag to a message gives you a visual reminder of it in some way.

To set a flag:

1. Right-click on the email, select ‘Follow Up’ in the ‘Home’ tab, and then choose a flag.

Creating a custom flag is done the same way as creating a category, as described above. To search for flagged emails, do the same as if searching for categories, though select ‘Flagged’ from the ‘Search’ tab.

Set your out-of-office message

Your out-of-office message will only be migrated from Gmail to Outlook if it happens to be active on switchover. Otherwise, you will need to set it up again in Outlook.

To create an out-of-office message:

1. Click on the ‘File’ tab, then select ‘Automatic Replies’.
2. Select ‘Send automatic replies’ and choose the options that are relevant to you in terms of adding dates, messages for internal and external contacts and click ‘OK’.
Access shared mailboxes

Shared mailboxes appear in the ‘Navigation pane’ under your personal University account. If you have a lot of folders, you may have to collapse the top mailbox using the small triangle to the left of the mailbox name to see shared mailboxes, or otherwise scroll down the ‘Navigation pane’.

Shared mailboxes have most of the same functionality as your personal University account, which means that you can organise emails with folders, categories and flags and create signatures. See the above section for information on creating signatures for shared accounts.

Mark messages as junk mail or not junk

You need to train Outlook so that it understands what you consider or do not consider to be spam. You may get more spam than you used to in Google at the start, this will improve as you train Outlook. By sending an unwanted message to the Junk folder, or retrieving a wanted message from the Junk folder, the spam filtering will improve.

To send an email to your ‘Junk’ folder:

1. Tick the box to select the email.
2. Click on the drop-down next to the ‘Junk’ option in the top menu and choose ‘Junk’ followed by ‘Block sender’.

While the spam filter is learning you should check your Junk folder more often than you did in Google.

To remove a message from your ‘Junk’ folder and return it to your inbox:

1. Select the email.
2. Select ‘Not junk’ to move it back to your inbox.

Use rules (filters and forwarding) to control incoming mail

Filters and forwarding in Gmail are called ‘Rules’ in Outlook, and you can set these up to automatically move (or delete) incoming messages to specific folders. Right-click on an email and select ‘Create rule...’ From the pop-up menu to get started.
Further support resources

See the University’s Outlook email support resources and frequently asked questions via:

- [www.bristol.ac.uk/email](http://www.bristol.ac.uk/email)

Outlook also has its own internal help. Just type into the ‘Tell me what you want to do’ box to the right of the ‘Ribbon’ tabs.

If you can’t find out what you need to do by using the above support resources, you can also contact the IT Service Desk for support:

- Web self-service: [https://servicedesk.bristol.ac.uk/tas/public](https://servicedesk.bristol.ac.uk/tas/public)
- Email: service-desk@bristol.ac.uk